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1. Introduction

1.1 Purpose

This document gives the overall design description of the FROG Project. It details how the user
will interact with the system. It also describes how the system passes information from one
section to another, while outlining the specifics of the coding sections of FROG. This includes
GUI prototypes, walkthroughs, system diagrams, and class diagrams along with their
descriptions.

1.2 ldentification

The goal of the FROG Project is the development of a device and platform-independent gesture
training and recognition system. The FROG recognition framework is created with the intent to
be used in motion-based recognition research through utilization of 3D accelerometer-enabled
mobile devices. The FROG project shall consist of a Hidden Markov Model-based training and
recognition framework supported by an intuitive and research-oriented GUI.

1.3 Scope

In its initial release, FROG will be packaged with a plug-in for Sun SPOTSs. Additional plug-ins
for compatible mobile devices may be written later based on a plug-in framework. In addition to
the necessary training and recognition modes, FROG will contain an evaluation mode as well as
a demo program for testing and demonstrating the capabilities of the project.

1.4 Overview

Section 2 - System Architecture: Description of hardware and communication architecture as
well as software architecture. Hardware and communication description is concerned with Sun
SPOT device and communication architecture. In software architecture a system architecture
diagram and a package diagram are presented.

Section 3 - Data Design: Description of the details concerned with structure and storage of log
and gesture session (library) files.

Section 4 - Detailed Design: Description of the detailed hardware and software design of
FROG. In software detailed design an in-depth class diagram (including hierarchy and
association) and a layout of user interaction with the system through the use of sequence
diagrams are presented.

Section 5 - External Interface Design: Description of the structure of the plug-in framework
constructed within FROG including details of what is needed in developing a plug-in.

Section 6 - Human Machine Interface (HMI): Layout of the intended GUI.
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2. System Architecture

2.1 Hardware and Communication Architecture

The Sun Small Programmable Object Technology or Sun SPOT device will be the only device
initially supported by FROG. Sun SPOTSs feature accelerometers and a low-power, IEEE
802.15.4 radio. Acceleration vectors can be gathered by these accelerometers and transmitted via
the radio to FROG for gesture training/recognition. The following diagram details the axes of
each accelerometer.

Sun SPOTs are programmable in Java, running a limited Java Virtual Machine called "Squawk."
All onboard Sun SPOT facilities, including radio and accelerometers, are accessible through the
Squawk and Sun SPOT APIs. The Sun SPOT plug-in for FROG will require additional code
designed to be executed on the Sun SPOT itself as well as a protocol to allow communication
between device and plug-in.
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Five types of messages will be required in this protocol:

e ACK - from host to SPOT, when the END_OF_DATA along with all gestures before it have
been received

o RESEND - from host to SPOT, if the host receives a datagram out of order, it can send this
message to instruct the SPOT to start sending from the last one faithfully received

e ADD FILTER - from host to SPOT, instructs the SPOT to add an additional active filter of the
host’s choosing

o REMOVE_FILTERS - from host to SPOT, instructs the SPOT to remove all its active filters

e ALIVE - from host to SPOT, a packet that makes sure the host and SPOT are still connected

e ACCELERATION - from SPOT to host, an acceleration message containing the order it should
be received in as well as three 32-bit integers that represent the acceleration multiplied by
100,000,000

o END_OF _DATA —from SPOT to host, a final message that lets the host delineate between
gestures

Keeping the protocol simple and communicating only what is necessary helps to alleviate the
potential performances issues related to the limited facilities of the Sun SPOT. This shall aid in
maintaining the ability to sample acceleration quickly enough to accurately map out a user’s
performed gesture.
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The following represents the FROG architecture. It distinguishes system structure as well as data

flow.
Mobile
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This is a diagram of the packages included in the FROG architecture.

Communication |

Plug-in

Data Display |

Data Processing |

Idle Directional

State Equivalence

Classifier |

}

Quantizer

K-Means

HMM Bayesian

K-Means++

User Interface

Logging

Log File

Gesture Library

System Architecture
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3. Data Design

3.1 Logging

Logging is crucial as it informs the user about the status and performance of the system. It is also
an extremely useful debugging tool for a developer.

The FROG Project logging system will be encapsulated in a simple class, Log. This class is
never instantiated but rather performs all the necessary logging through “out”, a method designed
with standardization and ease of use in mind. This method will write messages from any object
that calls it to a specified log file, the chosen JTextArea console window, and the system's
standard out.

The format of the log file is:

Sat Nov 21 17:08:29 CST 2009 class frog.Log: Start of Log
Sat Nov 21 17:08:30 CST 2009 frog.HMM: Instantiated
Sat Nov 21 17:08:31 CST 2009 class frog.-Log: End of Log

Each line begins with a date and time the message was created, followed by the contents of the
message — that is, a description of the relevant event.

Much of the Log's behavior can be customized. A user may choose the location and name of the
file that the system is using for logging. Since FROG has a modular GUI, a newly written GUI
can easily hook into Log to make use of and view system updates by specifying a JTextArea for
the FROG system. The Log class also contains booleans for toggling output of FROG's
subsystems such as the Classifier and Filters.

3.2 Gesture Libraries

Gesture libraries are saved using Java's built-in serialization feature. HMM and Quantizer are
both packaged into a Java serialized object file to be opened later. This cuts down on
development time for a save/load scheme for gesture libraries.

Gesture libraries contain only the HMM and Quantizer, both necessary for recognition of the
gestures in the library. However, because training instances are not stored, it is impossible to add
additional training instances to a gesture after saving the gesture. The user will have to delete the
gesture and retrain it if the performance of a particular gesture is unsatisfactory.
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4. Detailed Design

4.1 Hardware Detailed Design

We may be putting something in this section later. For now, it is still one of the great mysteries
of the universe.

Detailed Design Page 7



Design Document FROG

4.2 Software Detailed Design
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FROG

-Plugin
-Log

Log

-RecognitionPipeline
-TrainingPipeline *

+trainingMode()

+recognitionMode()

*

1

+logClassifier : boolean(idl) = true
+logFilters : boolean(idl) = true
+logFROG : boolean(idl) = true
+logHMM : boolean(idl) = true
+logPlugins : boolean(idl) = true
+logQuantizer : boolean(idl) = true
+logSystemOut : boolean(idl) = true

DeviceListener

+gesturePerformed()
+unexpectedDisconnect()

1 —

Plugin

-devices

+discover()
+connect()
+disconnect()
+disconnectAll()

+addFilter()
+getAvailFilters()
+resetFilters()
+calibrate()

+getConnectedDevices()

GUI
-FROG

+RunTraining()
+RunRecognition()
+RunEvaluate()
+RunDemo()
+ShowInfo()

+EXxit()
+GetFileRouteLoad()
+GetFileRouteSave()

\

+close()
+out() 1 1
+setLogFile()
+addTextArea()
+resetConsoles() *
GestureEvent
-accelerations
RecognitionPipeline TrainingPipeline -device
- - +getAccelerations()
-device -device N +getDevice()
-gestureSession -trainingSession 9
-currentGesture -trainingSet 1 (/
-models -traininglnstance Quantizer
+accelerationReceived() -quantizers N 1
+buttonPressed() -models rmm—
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+setDevice() +buttonPressed()
+setSession() +buttonReleased()
* +setDevice()
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* -map -map
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+
classify() -Quantizer " \;*,_J

BayesianClassifier

-model
+classify()

+getProbability()
+getDefaultProbability()
+train(in Instance)

*

+getProbability() : double(idl)
+getDefaultProbability() : double(idl)

Accel3D
% -x : float(idl)
-y : float(idl)
GestureHMM -z : float(idl)
-name : string(idl) +getX() : float(idl)
-numStates +getY() : ﬂoat(?dl)
-quantizer +g§dtZ(§) : float(idl)
-trainingSet +a
-trainHMM() +distanceFrom()
-initHMM() +GetMagnitude()
® +rescale()
-Loarg:;g(rzo +toArray()
+toString()

A

1

Device
-id
-type
+calibrate()
+addFilter()
+addGestureListener()

+calibrate()
+connect()
+disconnect()

+getAvailFilters()
+getShortName()
+notifyDisconnect()
+notifyGesture()
+removeGestureListener()

+resetFilters()

+setShortName()

+toString()

]

Filter

+ilter()

T

DirectorialEquivalence

-threshold : float(idl)

+filter()

-threshold : float(idl)
-referenceVector

+filter()
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4.2.1 Use-case model

User
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Recognition Mode

Evaluate Mode

Demo Mode

Training Mode

Recognize

N4 N
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~ 7/ A Load Library
\/\ \ <
/ ~ Ay
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4.2.2 Sequence diagrams

4.2.2.1 Connect

If a device is already connected, its information

is displayed when the connect window is displayed.
The user can disconnect from that device to see
available devices.

Click configuration option

Search for devices

Device discovery request

Return available devices

Display available devices

Select a device

Fm==1

Connect spgcified device

Display coonnected device ’_f ””””””””””””””””””””
e ,,,,,,,,,,,,,,,,,,,,

Search for filters

Return available filters

Display available filters <

|
Request filters on device

-

Display filters on device

i
I I

i i

I I

I |

I I

i i

I I

i i

I I

L i |
Add/remove filters i i i
\ | |
i i Add/remove filters i
| Update filter list 7 i
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I I

i i

I I

i i

I I

i i

I I
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I I

I I
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I I
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4.2.2.2 Demo Mode

|
| |
| |
| |
| |
Us?r } }
™ | |
| |
Click Demo } }
N |
. |
| |
| |
| |
| Display demo configuration !
TR L e ‘ !
| |
| |
Select number of players | i
A |
|
i
Perform Connection(s) }
|
Connection(s) completed o o |
Destroy existing pipeline(s) 1
i Create pipeline(s)

I

|
> Select library(s) |

o

Library(s) selected

Click "Begin Game”

Display demo window

},4444

e ___________________
Start demo
K ____ L
|
Perform gesture
|
|
|
L |
| |
| |
| |
| |
|
| |
|
! } Recognize gesture
! | Return most probable gesture
| |
; L & mmm o
|
| i
| |
| |
i
| |
|
| Game over i
|
___________________ !
|
|
Display gama statistics }
,,,,,,,,,,,,,,,,,,, |
|
L |
| |
| |
Click Exit } } Click replay to restart demo
' |
|
‘ |
| Exit Demo mode !
E I
! |
|
| |
| |
| |
| i
| |
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4.2.2.3 Evaluation Mode

I
I
I
i
I
Usér |
~ Click Evaluate |
I
I
I
i
L I
w i
| i
s Display Evaluation screen }
e i
I I
I I
Perform connection ! !
] I
Connection complete }
> |
I
i
T Destroy existing pipeline !
I
| Create pipeline
I
|
o

> Select library

Library selected

=71

Select evaluation parameters

Display gesture

p-----

e
T
i
Perform gesture
I
i
T I
! |
! |
! |
[ |
! |
| 1
i ! Recognize gesture
I
1 1 Return most probable gesture
1 &mmmm
I
! |
| |
| Display collected data 1
K |
} Possible actions at this point:
Modify display of data i Re-perform connection
! Load new library
| Perform gesture
T }
I I
I I
I I
Click Exit ! !
A I
I
‘ |
! Exit Evaluation mode |
o :
! i
I
! |
! |
! |
! |
! |
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4.2.2.4 Load Library

Session File

Request file contents
Return contents

O

Load library request
Serialize file into HMM

Click Load Library
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4.2.2.5 Recognition Mode
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RecognitionPipeline

Usgr
™ Click Recognize
L]
|
|
iR Display Recognition screen
e ,,,,,,,,,,,,,,,,,,
|
Perform connection(s) }
1
Connection(s) complete
>
e
|
|
|
|
|
|
o

> Select library(s)

Library(s) selected

Destroy existing user pipeline

Create user pipeline

This will be performed for as many users
as necessary (maximum of 4).

Return most probable gesture

e
| a
| |
—— |
Perform gesture
|
- |
| |
| |
| |
| |
| |
| |
| |
| |
| |
| |
| |
1 o
|
|
|
}
|
! Display collected data
K mm e
Modify display of data
Click Exit i}
|
| Exit Recognition mode
% ,,,,,,,,,,,,,,,,,,,,

> Recognize gesture

Possible actions at this point:
Re-perform connection

Load new library

Perform gesture
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4.2.2.6 Recognize

Quantizer

GestureHMM

Classifier

Filters

Send raw data

RecognitionPipeline

Translate data
Return translated data

Get probabilities
Return probabilities

Send filtered data

H
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4.2.2.7 Train

GestureHMM

U

uantizer

Send translated data

Send filtered data

Filters

Send raw data

TrainingPipeline

Return optimized HMM
e

<«

|

Click Save Gesture Set
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4.2.2.8 Training Mode

|
Usér

Click Train

Display Training screen

-
4\

Perform connection
Connection completed

Delete existing pipeline

Create pipeline

Load library
Library loaded

Modify training parameters

Create new training set

Perform gesture
|

Here, the user can perform as
many gestures as required.

Save gesture set

I
I
I
I
I
I
I
u
! Send training statistics Train gesture

Click Save Session

Serialize HMM

U Save training session
|
|
|
|
|

Possible actions at this point:
Re-perform connection
Load new library

Click Exit
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5. External Interface Design

To ensure the versatility of the FROG Recognizer of Gestures system a plug-in framework for
mobile devices shall be developed. The Plugin interface is to be implemented in the code of any
developers wishing to add support for their device with FROG. Plug-ins must handle all
communication with a device. Additionally, vectors must be normalized such that acceleration
measured by accelerometers is measured in g’s (and not m/s or some other unit). Plug-ins will
be loaded automatically at start up by searching the FROG “plugin\” directory for valid .class
files (classes that implement Plugin). Some devices require calibration to perform correctly, and,
as such, the Plugin interface features a “calibrate()” method which can open a custom-made GUI
interface specifically for calibration.

The “Device” class is to be instantiated for each device the plug-in discovers. A device is not
necessarily connected until the user has selected the device for use. The Device class is not
abstract or meant to be extended, but rather it contains all the functionality needed for any
device. Methods called on Device such as “getAccel()” or “connect()” are passed behind the
scenes as requests to the Plugin interface. Devices will keep track of the Plugin object that
created them in order to place the burden involved in plug-in monitoring solely within the
Device class and not in the exterior FROG controller class.

In the event that a device unexpectedly disconnects in the middle of operation,
“DeviceDisconnectedException” can be thrown by the methods in Device. This will be useful in
the GUI design as this error allows the user to become aware of such problems and to save their
current session before attempting to reconnect with the device.
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6. Human Machine Interface

The following is a prototype of the FROG user interface. This prototype gives a screenshot-
based walkthrough of the modes and use of the FROG Recognizer of Gestures product.

Screen 1.0: Main Menu

FROG Recognizer: Of Gestures

Welcome to FROG

FROG Recognizer Of Gestures

@-\“’ Train

® ke
ecognize
E

| @ Evaluate

Asr Demo
<

@° o)

Select a Mode

This is the main window of the program. From this window the user can access the different
modes. In order for this window to display, it is necessary for the system to find at least one

device plug-in to work with. If no plug-in is encountered, then the program will ask the user to
install a plug-in.

a) This button will display information about the program when clicked.
b) Exit button.
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Screen 2.0: Training Mode

FROG Recognizer. Of Gestures - Training Qg]
Parameters Device Set Up a Session Controls
[ New Session ] [ Load Session From File ]
SUNSPOT 2C06 i [ Train New Gesture Set ] [ Save Gesture Set ]
Quantizer K-Value M| A o

Restore Defaults - —
Exit Training

Vectors Display | Other Graphical Display

—
z Circle ‘ vl
AMZ T —
/< - AM 9
731 y X = 12563 Star No Image —t'
x Y =5.2365
Z =2.8569
>Welcome !! A -~ Terminal Controls
>Training session started
>Device Cfonnect: SunSPOT 3B7D Log Data [ Dump raw data to file ]
>Waiting for Input...
(xy,2) out [ Choose Log File m
9 Show Data 01
Execution Time Terminal In
New Window
Device Connected: Sunspot 3B7D 0
v Status: Recording
< >

Reading data from SunSPOT 3B7D

This is the window for Training mode.

c) Parameters: This panel will allow the user to modify parameters for the training process.
d) Session Controls: This panel will allow the user to control the current gesture session.
i.  New Session: Will create a new gesture session. Each gesture session can be
saved into a file.
ii.  Load Session from File: Will load a previously saved session from a file (using a
standard open file dialog).
iii.  Train New Gesture Set: Will add a gesture set to the currently opened session.
Upon clicking on this button, Screen 2.2 (Train New Gesture) will be displayed.
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The ability to train a new gesture set will not be available if the last one created
has not yet been saved.

iv.  Save Gesture Set: Will terminate the collection of instances for a gesture set and
then perform the training of the gesture.

v.  Exit Training: Will terminate the training session, close screen 2.0, and open
screen 1.0.

e) Graphical Displays: This panel will show different graphical displays such as a graph of
3D acceleration values as well as the clusters from the k-means algorithm.

f) Session Panel: This panel will show the gestures that are part of the current gesture
session and allow the user to load an image (using a standard open file dialog) to
represent each gesture by clicking on the icon to the right of the current image.

g) Terminal: The terminal will serve as the primary method of providing feedback to the
user in real-time about the actions being performed, performance etc. To the side of the
terminal there will be controls for the user to select the feedback needed (see h.) This
description applies to the terminals found in other modes.

h) Terminal Controls: The terminal controls will allow the user to choose the feedback he
or she wants to appear in the terminal. In Training mode, there will be the option of
displaying the acceleration values of each axis and performance of the algorithms
involved. More controls may be added during the design process. Some other actions that
those controls allow the user are:

i.  Dump Raw Data to File: Will allow the user to choose a text file where the
acceleration data received from a connected mobile device will be dumped. Note
that this capability is exclusive to the Training mode screen.

ii.  Choose Log File: Will allow the user to save the contents being posted in the
terminal to a text file. Upon clicking this button, the user will be prompted with a
standard save file dialog for the user to select the location and name of the text
file.

iii.  Terminal in New Window: Will display the terminal in a separate window for
easier manipulation (see Screen 2.1).

i) Device Status Display: This panel will let the user know the current status of the mobile
device used to input data to the system.

j) Connection Panel: This panel will give the user the option of setting up a device to work
with the system. This panel will appear (with a different configuration) in other windows
and will allow the user the following capabilities:

i.  Device: Will allow the user to choose the kind of device to be set up. The choices
of this combo box will correspond to the plug-ins installed.

ii.  Threshold: Will allow the user to prescribe a threshold to be used with
recognition performed with that mobile device.
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iii.  Connect: (-~) Will utilize the device’s corresponding plug-in to carry out
connection of the mobile device. If any further user action is necessary, the plug-
in is responsible for requesting such actions from the user.
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Screen 2.1: External Terminal

FROG - Console Q@
v
>Training session started Log Data
>Device Connect: SunSPOT 3B7D (x,y,2) out
>Waiting for Input... Show Data 01
Execution Time
Dump raw data to file
Choose Log File
v
< >
Training Mode Console

This window is an external terminal. It will display the output given to the user by the mode
currently running.

k) Terminal: Refer to Screen 2.0, section g.
I) Terminal Controls: Refer to Screen 2.0, section h.
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Screen 2.2: Train New Gesture

FROG - Train New Gesture

Name | Circle | [ Add Image ]

Ok Cancel

This window will allow the user to name the new gesture to be created and will also give the user
the ability to attach a symbolic image to the gesture for easier identification of the gesture’s
semantic meaning in other modes.
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Screen 3.0: Recognition Mode

FROG Recognizer; Of Gestures - Recognition

ID: Josh
Library: BasicShapes.ag

Load New Library

.o Device Connected: SunSPOT 3B7D
= Status: Recording

=

Load New Library

- "2 Device Connected: SunSPOT 415E
Status: Recording

ID: Ford

Library: RoundShapes.ag

Device Device .
SunSPOT 3B7D  w A SunSPOT 2C06 v N
Threshold Threshold
0.25 v 0.25 v

Load New Library

Device Connected: SunSPOT 2C06
Status: Recording

ID: Jose
Library: ComplexShapes.ag Slot 04
Device ° Device .
X <
Threshold Use the Device menu at Threshold
0.25 v The right to set a device 0.25 -

To work with this slot.

Load New Library

No Device Connected
Status: Device Not Found

*

EEX

>Welcome !! L~
>Setting Recognition session...
>Slot 01 Device Connect: SunSPOT 3B7D
>Slot 02 Device Connect: SunSPOT 2C06 I Exit Recognition l o
>Slot 03 Device Connect: SunSPOT 415E
>Slot 01 Loading Library: BasicShapes.ag - Session Started for: Josh
>Slot 02 Loading Library: RoundShapes.ag - Session Started for: Ford Terminal Controls
G >Slot 03 Loading Library: ComplexShapes.ag - Session Started for: Jose
>Starting Recognition session... Log Data
> Ford >> Circle (99% certain) _—
> Jose >> Gesture not recognized, sorry! Communication Data e
> Josh>> Square (50% certain) Show Certainity of Rec. Terminal In
> Jose>> Circle (20%) New Window
v
< >

Recognition session started...

This is the window for Recognition mode.

m) User Panel: This panel will handle one user. There will be four of these slots in Screen
3.0. Each one will allow the following actions:
I.  Connection Panel: Refer to Screen 2.0, section j.

ii. Load New Library: Will allow each user to select his or her own library (gesture
session file) to be used for recognition. Upon clicking this button, the user will be
prompted with a standard open file dialog.

User Panel (Unconnected): This User Panel shows the appearance of such a panel when
no user is connected.

Exit Recognition: Will terminate the current recognition session, close Screen 3.0, and
return to Screen 1.0.

Terminal Controls: Refer to Screen 2.0, section h.

Terminal: Refer to Screen 2.0, section g.

p)
a)
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Screen 4.0: Evaluation Mode

FROG Recognizer: Of Gestures - Evaluation

Session Settings

o Gesture Library Loaded: BasicShapes.ag

[ Load New Library ] [ Finish Evaluation Session ]

Customize Evaluation Session

Sample Size:

Randomize

Design Document
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Recognition:

Gesture Correct Incorrect Av. Certainty
Circle 12 0 50% N
e Square 7 3 80% Ignore Last gesture |5/
[] star - - Device Set Up
i 0,
Triangle 3 1 75% Device )
Sun Spot v Jt
Correct — Incorrect - Unrecognized Threshold o
0.25 v
Live Statistics
>Welcome !! o
>Setting Evaluation session... Terminal Controls
>Device Connect: SunSPOT 3B7D
>|D: Josh Log Data Choose Log File
>Loading Gesture library [100%] Communication Data m
>Library Loaded: BasicShapes.ag . -
>Starting Evaluation session...\ Show Certainity of Rec. ’\E rn\]/lvr}ﬁ:j(l)n
>Gesture Recognized: triangle Excecution Time e ncow
>right !
>Gesture not recognized, sorry!
>Gesture Recognized: circle
>wrong, sorry! . ;) Device Connected: SunSPOT 3B7D
Status: Recording
v
< >

Reading Data from Sun Spot 387D

This is the window for Evaluation mode.

r) Session Settings: This panel will allow the user to load a library or finish the session.
I. Load New Library: Refer to Screen 3.0, section m.
ii.  Finish Evaluation Session: Will terminate the current evaluation session, close
Screen 3.0, and return to Screen 1.0.
s) Customize Evaluation Session: This panel will allow the user to modify the parameters
of the evaluation session.
i.  Session Table: Will allow the user to select which gestures are to be part of the
evaluation as well as display real-time statistics.
ii.  Sample Size: Will allow the user to input the sample size for evaluation.
ii.  Randomize: If selected, will allow the user to be prompted for gestures in a
random fashion. Otherwise, gestures will appear sequentially.
t) Gesture Prompt: This panel will display the name and associated image of a gesture as
the gesture is requested by the system.
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u) Statistics Displays: This panel will display recognition evaluation statistics in graphical
and tabular format.

v) Connection Panel: Refer to Screen 2.0, section j.

w) Terminal Controls: Refer to Screen 2.0, section h.

X) Terminal: Refer to Screen 2.0, section g.
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Screen 5.0: Demo

FROG - Demo Game

This is the window for Demo mode. To utilize Demo mode, an appropriate library must be
loaded. That is, Demo mode will require a certain set of predefined gestures to be trained within
the library chosen.
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Screen 6.0: Device Connection and Set Up

Device Connection and! Set Up

Device

Devices available

Filters Set Up

Filters available

SunSPOT 3B61 a | Discover
SunSPOT 4118

SunSPOT 1E98

SUnSPOT 2AAE

Filter 01
Filter 02
Filter 03

Close

<<

Filters to be used

Filter 04

Device Connection and Set Up

Device

&

Device Connected:
SunSPOT 415E
Status: Recording

Disconnect

Filters Set Up

Filters available

Filter 01
Filter 02
Filter 03

Close

<<

Filters to be used

Filter 04

y) Devices: This panel will display devices that are successfully communicating with
FROG. The list can be refreshed with the discover button, and a device can be selected

with the connect button.

z) Filters Setup: This panel will display available filters in the left column and selected

filters in the right column.

aa) Connection Dialogue: This panel will display the state of the selected device, including
the device name and connection status.
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